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Preface
1. Document Conventions
This manual uses several conventions to highlight certain words and phrases and draw attention to
specific pieces of information.
1

In PDF and paper editions, this manual uses typefaces drawn from the Liberation Fonts set. The
Liberation Fonts set is also used in HTML editions if the set is installed on your system. If not,
alternative but equivalent typefaces are displayed. Note: Red Hat Enterprise Linux 5 and later include
the Liberation Fonts set by default.

1.1. Typographic Conventions
Four typographic conventions are used to call attention to specific words and phrases. These
conventions, and the circumstances they apply to, are as follows.
Mono-spaced Bold
Used to highlight system input, including shell commands, file names and paths. Also used to highlight
keys and key combinations. For example:
To see the contents of the file my_next_bestselling_novel in your current
working directory, enter the cat my_next_bestselling_novel command at the
shell prompt and press Enter to execute the command.
The above includes a file name, a shell command and a key, all presented in mono-spaced bold and
all distinguishable thanks to context.
Key combinations can be distinguished from an individual key by the plus sign that connects each part
of a key combination. For example:
Press Enter to execute the command.
Press Ctrl+Alt+F2 to switch to a virtual terminal.
The first example highlights a particular key to press. The second example highlights a key
combination: a set of three keys pressed simultaneously.
If source code is discussed, class names, methods, functions, variable names and returned values
mentioned within a paragraph will be presented as above, in mono-spaced bold. For example:
File-related classes include filesystem for file systems, file for files, and dir for
directories. Each class has its own associated set of permissions.
Proportional Bold
This denotes words or phrases encountered on a system, including application names; dialog box text;
labeled buttons; check-box and radio button labels; menu titles and sub-menu titles. For example:
Choose System → Preferences → Mouse from the main menu bar to launch Mouse
Preferences. In the Buttons tab, select the Left-handed mouse check box and click

1
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Close to switch the primary mouse button from the left to the right (making the mouse
suitable for use in the left hand).
To insert a special character into a gedit file, choose Applications → Accessories
→ Character Map from the main menu bar. Next, choose Search → Find… from
the Character Map menu bar, type the name of the character in the Search field
and click Next. The character you sought will be highlighted in the Character Table.
Double-click this highlighted character to place it in the Text to copy field and then
click the Copy button. Now switch back to your document and choose Edit → Paste
from the gedit menu bar.
The above text includes application names; system-wide menu names and items; application-specific
menu names; and buttons and text found within a GUI interface, all presented in proportional bold and
all distinguishable by context.
Mono-spaced Bold Italic or Proportional Bold Italic
Whether mono-spaced bold or proportional bold, the addition of italics indicates replaceable or
variable text. Italics denotes text you do not input literally or displayed text that changes depending on
circumstance. For example:
To connect to a remote machine using ssh, type ssh username@domain.name at
a shell prompt. If the remote machine is example.com and your username on that
machine is john, type ssh john@example.com.
The mount -o remount file-system command remounts the named file
system. For example, to remount the /home file system, the command is mount -o
remount /home.
To see the version of a currently installed package, use the rpm -q package
command. It will return a result as follows: package-version-release.
Note the words in bold italics above — username, domain.name, file-system, package, version and
release. Each word is a placeholder, either for text you enter when issuing a command or for text
displayed by the system.
Aside from standard usage for presenting the title of a work, italics denotes the first use of a new and
important term. For example:
Publican is a DocBook publishing system.

1.2. Pull-quote Conventions
Terminal output and source code listings are set off visually from the surrounding text.
Output sent to a terminal is set in mono-spaced roman and presented thus:
books
books_tests

Desktop
Desktop1

documentation
downloads

drafts
images

mss
notes

photos
scripts

stuff
svgs

svn

Source-code listings are also set in mono-spaced roman but add syntax highlighting as follows:
package org.jboss.book.jca.ex1;
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Notes and Warnings
import javax.naming.InitialContext;
public class ExClient
{
public static void main(String args[])
throws Exception
{
InitialContext iniCtx = new InitialContext();
Object
ref
= iniCtx.lookup("EchoBean");
EchoHome
home
= (EchoHome) ref;
Echo
echo
= home.create();
System.out.println("Created Echo");
System.out.println("Echo.echo('Hello') = " + echo.echo("Hello"));
}
}

1.3. Notes and Warnings
Finally, we use three visual styles to draw attention to information that might otherwise be overlooked.

Note
Notes are tips, shortcuts or alternative approaches to the task at hand. Ignoring a note should
have no negative consequences, but you might miss out on a trick that makes your life easier.

Important
Important boxes detail things that are easily missed: configuration changes that only apply to
the current session, or services that need restarting before an update will apply. Ignoring a box
labeled 'Important' will not cause data loss but may cause irritation and frustration.

Warning
Warnings should not be ignored. Ignoring warnings will most likely cause data loss.

2. We would like to know your opinion
If you find any errors in this manual, we welcome your suggestions. In the case of a typographical or
concept error, you can submit it by mail including the following information:
Manual's identifier:Installation_rBManager_Enterprise-v.3 [EN](201909), chapter or section and page
number in which there is an error, and the part of text that contains that error.
This information allows us to easily locate the error and correct it in order to improve the
documentation accompanying our products.
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We also appreciate any suggestions regarding the mode exhibition or organization of information to
help us optimize our manuals.
Always check the latest version of the documentation available at http://support.redborder.net
You can send your comments to the email address: info@redborder.net

ENEO Tecnología S.L.

Parque Tecnológico de Bizkaia, Building 500 - Floor 1.
Bilbao
Derio (Bizkaia)
48160
+34 607 407 404
Spain
info@redborder.net

3. Welcome to redBorder
Thank you very much for downloading or purchasing version 3 of redBorder.
This manual is intended for users who have the Enterprise version.

3.1. Knowing the Official Manager Installation Guide
This guide contains very useful information that will help you accurately perform the installation of
redBorder Manager.
It explains in detail how to navigate through the Manager Installation Wizard and is just as valid if you
got a DVD installation as if performed the download directly from the ISO. Thanks to the configuration
wizard you can configure the manager.
his document is just as ideal for users who want to replace the the old version, as it is for those who
are installing redBorder version 3 for the first time.
If you’re an experienced user and have already performed the installation of redBorder on other
occasions, you can skip directly to chapter 3, in which you learn how to move in redBorder web
platform.

4. Requirements for the implementation of redBorder
The redBorder platform can be installed through 2 possible infrastructures:
• Physical machine: local drive of your computer (Hardware).
• Virtual machine: structure of virtualization or Cloud.

viii

Versions of redBorder Manager software

Important
Requirements for the installation of redBorder Manager from a physical computer:
Memory and Storage: 60GB for hard drive and a minimum of 16GB of RAM. However 32GB
of RAM recommended. (This figure depends on the number of sensors assigned).
In the case that a cluster has been created, two network interfaces are necessary: One for
network management (Management IP Address) and one for network synchronization (Sync IP
address): If you have created a cluster two network interfaces are required.

Cloud Compatible Solutions
• VMWare
• Open Stack
• Amazon Web Services (AWS)

5. Versions of redBorder Manager software
This document addresses the installation of the redBorder Manager that includes the following
software versions:
• Apache Zookeeper 3.4.6
• Apache Kafka 0.10.0.1
• druid 0.12.3
• postgreSQL 9.2.10
• chef 11.14.6
• nginx 1.6.2
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Chapter 1.

What is redBorder?
redBorder is the ultimate open, active and scale out Cybersecurity Platform and real time Network
Traffic Analysis (NTA). It´s based on Big Data technology for enterprise and service providers.
It´s capacity for ingesting, analyzing and reporting large amounts of data has been developed and
tested in very high demand environments such as Network Traffic Analysis, Cybersecurity or the
analysis and reporting of connections through wireless networks in venues.
The platform unifies the different data sources provided by the Apps and the probes. In addition, it
includes a series of common features: dashboards and customizable reports, correlation, analysis
engines, user management and layered storage.
Apps live inside the platform and are installable as if they were plugins. These focus on digesting new
types of data.
The probes live off the platform, but are managed from it and their function is the creation of new types
of data and inspection capabilities.
Depending on the Apps that are integrated in the platform, the user will see one or other options in the
menu bar. The Apps that are available in this new version of redborder are the following:
• Traffic
• Mobility
• Intrusion
• Vault
• Social
• Monitor

1.1. Basic scenario for installing redBorder
A typical basic proposed scenario for the solution consists of a set of sensors arranged in different
sensitive points of the network organization, that will connect with a Manager or cluster of managers
for its management and monitoring.
These points are formed by network links, called segments, which circulate sensitive traffic in which
the sensor will analyze in a more or less transparent way, depending on the mode set (IPS/IDS or
Flow).
For the planning of the installation of sensors, you should consider some fundamental aspects:
• The bypass segments (specific interfaces of semi-detached networks, normally with bypass
support) will intervene in the middle of traffic for analysis.
• The management interfaces (in the form of bonding) for remote access as much from regular host
as from the Manager.
• The IPMI access interfaces for hardware remote management (SOL connection or Serial Over
LAN, iKVM and ipmi commands like start, restart and shutdown).
For the Manager a specific hardware will not be necessary, the only condition is the existence of
one or more network interfaces.
1
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Note
If you have created a cluster two network interfaces are required: one for the management
network (Management IP Address) and one for network synchronization (Sync IP address).
In this way it allows for the creation of a bonding for the management and connection with sensors,
and another bonding (optional) for communications to other networks. Both systems support the
802.1q standard for virtual LAN (optional to the configuration time).

Warning
It is VERY IMPORTANT that the configuration of the Manager (or cluster of managers) is
performed before configuring the sensors.
The Manager must be operational and in a network accessible to the sensors. Some of the
sensor configuration processes depend on the access to the Manager.

2

User interface structure of the installation program menu

Basic scenario for installing the Manager

1.2. User interface structure of the installation program
menu
Menu, submenu and line commands

3
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User interface structure of the installation program menu
Menu
On the left side of the screen is a list of available options. To select any of them, just enter the line
where you see Selection, the number or letter corresponding to the option you want to choose.
Submenu
In the case that your selected option is able to perform different options, a submenu will appear on the
right side of the screen.
Line commands/ program selector options
In the upper margin, and graphically separated from the menu and submenu, we find the area in which
it should indicate the selections in the line where you see Selection and enter the commands or
information that is requested to execute the relevant actions. In this space we will see the system’s
date and time (UTC by default).

1.2.1. Selection of options
Predetermined options
In some cases, the system displays a series of defaults. If this is the answer to a question, the default
option set will be displayed in capital letters.

4
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Selection of predetermined options
Available options in the redBorder installer menu
• Default selection option: pressEnter.
• Other options: enter the corresponding letter or command.
• Exit: when you want to exit a screen to go back the initial menu, select the quit, option by typing
the letter q.
• Apply changes: to save the modifications performed and apply the changes, select the option
apply by typing the letter a.

Available options in the redBorder installer wizard

Warning
Need to "apply" to activate changes
If you see this message then you must select the a. option. Otherwise the system will not save or
apply the changes.

5

6

Chapter 2.

Installing redBorder Manager
Enterprise
Thanks to the installation wizard you can leave the manager configured and ready quickly and easily
without having the need for special programming skills in Linux.

Installing with simple wizard

Note
To install the Manager, you can follow a complete guide from our support page by accessing this
link: https://support.redborder.com/hc/en-us/articles/360000962497-RedBorder-EnterpriseInstallation-Guide

7
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redBorder web platform
Once the Manager installation process has finished, the user can access the redBorder web platform
in the address bar of their IP management browser assigned to the Manager.
https://IP-managerAddress

Screen access to the redBorder platform: username and password

Note
You can login to the platform using the account indicated by default: admin or
admin@redborder.net and the password that has been inserted in the Manager installation
process.

Warning
The web management will not work if you try to access it through a web that isn't encrypted.
As soon as you've accessed the redBorder platform, the first thing you'll see is a dashboard where
you will find different metrics and data about the status of sensors, domains, etc.

9
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This home screen is fully customizable. The user will be able to create as many dashboards per profile
1
as deemed necessary.

Home screen administrator of the Manager: dashboard

3.1. Interface structure of the redBorder platform
There is a structure that is repeated for all interfaces in the redBorder web platform. Knowing these
2
features will help navigate the web in a convenient and easy way.
• Menu bar: here you will find direct access to all sections of the redBorder platform. It is subdivided
into two different areas according to operability:
a) Analytical area (top left margin): in this area you will find all the data collected by the sensors
shown in different metrics and reports.
b) Configuration area (top right margin): configuration options and management of the Apps and
redBorder platform.
• Submenu: shows the available options according to the section you are consulting.
• Main area: this is the content section. In this area the data is shown in different metrics and graphs
that are completely customizable.
• Summary: below the graph you will find a summary of the information shown in the metric, providing
the total values.

1

In the case of the Community version, the number of customizable dashboards is limited to one per user profile.
The attached image corresponds to a redBorder installation with the active Apps of Traffic, Intrusion and Mobility. The structure
will be the same for any redBorder installation that is performed, depending only on which Apps are available in the top menu
bar, and whether or not they are activated.
2
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Included options in the menu bar
• Search engine: allows to quickly search any feature in the data table with the attribute that is being
consulted. You only have to enter the IP, sensor, client, etc. that you want to consult. In addition, the
searches can become filters as we will see further ahead.
• Data table: provides details of the information displayed in the metric. Furthermore, they can
perform different actions by rows. These actions depend on the tab/App we are consulting.

3.1.1. Included options in the menu bar
Let's do a quick overview of the options that can be found in the menu bar, in the area of analysis and
configuration. In later sections functionality and configuration of these options will be analyzed.
Dashboard: Provides a summary of the events received by the sensors, displaying them in different
metrics. This is the screen shown by default when you log into the redBorder platform.

Dashboard
Events: Next, the user will be able to see events whose information comes from the sensors registered
in their corresponding section. Later, it will be explained in detail what function each one has, and how
these sensors are registered. In the attached screenshot: Traffic

11
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Events
Configuration area
Search engine: facilitates locating elements/values of the platform according to the search engine term
entered by the user.
Sensors: Displays a list of the added sensors and the organization tree. It also contains global and
local policies defined for each domain.

List of sensors
12

Included options in the menu bar
Tools: Provides a list of the configuration options that are available to the administrator profile and in
read mode for the rest of the users.

Available options in Tools
Administrator: this section shows a list of notifications, as well as the different options available for
managing users, contextual help of the platform and the safe disconnect button: Logout.

Available options in Administrator
13
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Show Help: Enabling this option will activate a pop-up window providing help during the Manager
administrator navigation. It is identified with a question mark.

Help activation

14
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Events
In this section the user can display, analyze and manage events collected by sensors.
redBorder offers maximum network visibility thanks to the many options of representation and
visualization of data that our App provides. Be sure to check the sections Available options in the
redBorder submenu and Filter events to discover the versatility to show only the information you want
to analyze at a certain time and certain conditions.

4.1. Modules
Redborder has a module for each main functionality. Each one uses different technologies and has an
independent interface. All modules need a sensor that provides the module the data.

Redborder Modules

4.1.1. Traffic
Traffic module uses netflow data to extract information about all the traffic from the sensor. The
module provides information as IPs, protocols, locations and much more.

4.1.2. Intrusion
Intrusion modules uses data from IPS sensor to show intrusion events based on Snort signatures. It
can show events such as DDoS or MITM attacks.

4.1.3. Monitor
Monitor modules uses data from SNMP, Redfish and Ipmi protocols to show the status of the
infrastructure.

4.1.4. Social
Social modules uses data from Twitter sensor to show information from that social network. It can be
used to show the behaviour of the social info about a topic.

4.1.5. Vault
Vault module uses syslog data to provide information about events from different origins, like the
category, target, event action and more.
It is also possible to expand the capabilities of the Vault module through the extensions that add
compatibility with other manufacturers.

4.1.6. Mobility
Mobility module provides location information from sensors from the network APs. It can be used to
show how the people is moving in a bulding.

4.1.6.1. Reports
Reports module allows the user to have periodical reports with information about Redborder platform.
15
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4.2. Modules: menu and options
In the area of analysis of the menu bar (left side), we find different sections corresponding to the Apps
that we have integrated into the redBorder platform.
Next we will see the different options for data visualization, chart types, granularity (maximum degree
of temporal detail that consults events) and attributes that can be combined to obtain a completely
customized network traffic viewer.

General view of module section

4.2.1. Available options in the submenu
Options in the submenu
• Filters: allow users to isolate a portion of information for more detail. In this tab, you can view the
number of filters that have been applied and perform actions on them:
-Advanced Search.
-Create an alarm.
-Create a widget on.

16

Available options in the submenu

Filters
• Views: offers different options for displaying information.
-Raw: raw data events.
-Tops: the total sum of data from different events to display as one.
-Compare: comparison of events within a period of time.
-Unique: shows events that happened only once.

17
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Views
• Aggregation: there are different values or units of measure in which the data can be displayed. For
example, flows per second (flows/s) or bytes per second (bps). Note that each module has its own
aggregation choices.

Aggregation

18

Available options in the submenu
• Granularity: indicates the degree of temporal detail that can display data. The minimum value is
one minute granularity.

Granularity
• Graph: shows the different types of graphics from which we can choose to display the data. The
types of charts available vary depending on the selected view. These are as follows:
-Area
-Line
-Bars
-SBars
-Stacked

19

Chapter 4. Events

Graph
• Options: in this section the user can perform various actions to manage the data shown in this
section. The options vary depending on the selected view.
-Show Total
-Show total filtered/Hide Total Filtered: shows or hides the graph considering
selected filters.
-Time Machine
-Export to CSV
-Save tab as default

20

Available options in the submenu

Options
• Attributes: Events received by the Manager consist of a “column: value” pair. The values given in
each column can be understood as data specific to the event which are the ones that really provide
information. These are called “attributes”.
The attributes can be displayed in several ways: as tabs or columns. Add tabs/Columns
depending on the view that we are consulting.

21
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Attributes

4.2.2. Body of the screen: filtering by time range, attribute tabs and
views
Filter by time range: direct access to filtered events based on a period of time. Last 1h, 2h, 3h, 12h,
24h, last week, last month, custom filter...
There is the possibility to select a different date range to those offered by default. Depending on user
requirements, you can make a selection of personalized time through option Custom. Later it specifies
the procedure to follow to perform a customized temporary filter.
Attribute tabs: classified network traffic information by attributes. Navigating through each of the tabs
we can know in detail the values associated with the attributes that have been selected.

Note
The user can change the order in which the tabs are displayed at any time. To do this drag and
drop the tab on the position where you want to put it.
This section is not displayed on the Raw view.
View: in this area the data is displayed according to the selected view and type of graphic. When
positioning the cursor on any of the points that make up the graph, a dialog box displays in detail the
information shown for that instant in time, aggregation and attribute.

View

22

Summary, search engine and data table

4.2.3. Summary, search engine and data table
Summary: under the View area is a summary relating to all loaded data displayed, both at the view
and in the data table. In the following order, this summary indicates the total aggregation value of all
loaded data, the total aggregation value of all loaded and selected data, the number of rows of loaded
data and the value percentage added from the loaded data out of the data total.
Search Engine: allows you to search by attribute. Searches automatically become filters as we'll see
a bit further.
Data table: shows the values classified by the type of selected attribute. For example, each row may
be showing each of the IPs of origin (Column/Attribute: SRC Address) with the percentage detail of
bytes (aggregation) that is consuming that element within the network.
For the isolated analysis of one or more elements of this bar (select as filter), you need to click on the
item you want to filter. For multiple selection simply hold down Shift.

Note
When positioning the mouse over any of the elements of the data table a menu is displayed
showing the different actions that can be performed on that item. Depending on the attribute type,
sort options are displayed in the context menu.

Summary, search engine and data table

4.3. Filter events
In the submenu of the section there are several options that allow us to view events according to our
analysis needs.

23
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One of these options is Filters which allows the filtering of events according to the user-defined
criteria. These filters can be saved to be used later as a screen for the display of events.
Filtering options:
• Filter zoom: graphically isolated events according to a time range.
• Filter Selected: allows us to convert one or more filter elements in the table.
• Advanced Search: allows you to set conditions for an advanced search acting as a filter. Very
useful for isolating and analyzing concrete data.
Filter actions:
• Saved filters: shows a list of saved filters.
• Create an alarm: allows us to set an alarm based on the filters applied. This action will be seen
in detail in the Tools chapter (Tools).

Tools>Alarms
• Create a widget on: creates a widget based on the search criteria that can be included in
dashboards or reports. However, not all widgets can be applied to reports.

24

Is it possible to only filter the events in a given period of time?

Events filtering options and available options

4.3.1. Is it possible to only filter the events in a given period of
time?
Is possible to isolate the corresponding events to a period of time to analyze in more detail the data
associated with the selected attribute.
There are five ways to make a temporary filter:
• Filter by time range
• Filter Zoom
• Custom filter
• Advanced search
• Filter by attribute
Filter by time range
A simple and quick way to view only the events corresponding to a specific period of time is to select
some of the options that provide tabs timeline filtering:

Filtering events: timeline
The user can select a period of time manually. To do this, click the mouse on a specific point on the
graph, drag and drop to the desired time instant. Ater that, you can see this period of time expanded in
the graph.
25

Chapter 4. Events
In the indicated submenu you will see Filter Zoom.

Filtering of events: Filter Zoom
Filter by range of time or Custom filter
The tab Custom of line filtering time range allows a custom filter. By dragging the mouse from one
point to another in the month you want to consult, we will see the specific dates to be taken into
account in the filtrate.Thus, we have the view for that time range and the table below show only the
data contained in this strip. To do this click on the submenu Filters Start Time End Time
indicated for this filter.

Note
When you perform a custom filter or Custom we can isolate in the graphic data for a period of
time.
It's also possible to select the time period directly from the temporary bar that appears in the top
margin.
Click on Submit to apply filter.
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Filtering events by range of time: custom filter
Advanced search
To do this click on the tab Filters that displays a submenu in which we find the option Advanced
Search.
This is the option that allows more detail, since it is the user who determines the conditions of the
search, and therefore filtering. You can choose from all available attributes for this App.
You can add as many filtering conditions as it deems necessary, just make sure to indicate the
attribute, the start date and the end date you wish to consult.
• Add search rule: click (+)
• Delete search rule: click (-)
To start this search, simply select the option Submit Search.

Filtering events: advanced search
You can save this search settings as a filter, thus, it will be available to consult at any other time in
both the option View Saved Filters as in Saved filters which you will find in the context
menu of the filters.
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To load a saved test you can use View Saved Filters button, selecting the filter and clicking in Add
Filter button.

Filtering events: saving filter
Filter by attribute
There are two ways to convert a value of an attribute in a filter:
• Search Engine: enter the attribute value you want to find and press Enter.
The chosen filter will automatically be included. You can include as many filters as searches as are
conducted.
• Column selection in the table: you can select one or more rows of the table to isolate the data
relating to such elements. For multiple selection, just press the left mouse button on the ranks of the
different elements you wish to filter; if you want to deselect, click again on the elements. The user
can also help by pressing Shift.
Once the rows are selected, there will be the option to include or exclude the graphical elements,
as well as the data table. To go back to include them press the button Filter Selected located
on top of the data table. To exclude them, it's necessary to press the button Exclude Selected
located next to the previous button.

Include/exclude filter
In the case of an individual selection, its possible to perform the filter or exclusion more quickly:
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Reputation and monitoring IPs
a) By clicking on a name of a sensor data will be included in the view. In this moment, the label will
display a color that corresponds to the line/area/stream/bar shown in the view. To exclude, click on it
again.
b) Opening the drop-down next to each item in the table and contains the following options:
• Filter: adds the appropriate filter to include the element of the data presented.
• Exclude: adds the appropriate filter to exclude the element of the data presented.
• Copy to clipboard: the value of the selected item is copied to the clipboard so it is available for
future use.

Filtering events: Filter by attribute

4.4. Reputation and monitoring IPs
Attributes source and traffic destination (SRC Address/DST Address) allows to perform the following
actions in order to facilitate a more comprehensive analysis of the origin and destination of the traffic
that passes through our network:
Create object: this allows to put a name and/or description allowing the location of an item more
quickly and easily. For example, if we know the machine associated with a particular IP address, this
option allows you to rename it for easier identification.
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Renaming an IP: Create net object
We find also the option to consult outside sources to help us identify the location and reputation of the
consulted IP's.
• uTrace
• Trusted Source
• Whois.sc
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uTrace
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Trusted Source
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Whois.sc
Basic Source Lookup: it is possible to obtain a complete summary of the information associated with
the consulted IPs. By selecting this option a popup window will appear with two tabs:
Whois: shows the result of the Manager query to whois where they obtain, among other information,
who owns that IP, reputation, etc.
DNS: the Manager performs a reverse resolution that lets us know the DNS associated with the IP
consulted.
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Basic Source Lookup: information query IP/DNS

4.5. Views: multiple options for data display
Views provide multiple perspectives to display the associated data to network traffic.
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Note
Remember in the section Dashboard you can create custom widgets for each type of App
indicating a type of view to display events.
The views that are available for Flow are:
• Tops: aggregation of events based on a unit to show the most prominent. The total sum of data
from different events to display as one.
• Raw: view all raw data events, classified by attributes and time slots.
• Map: heat map in which the IP (clients) are shown and access points involved in the data flow.
• Compare: comparing time intervals to analyze differences in network status.
• Unique: shows the different elements that have interacted with the network according to attribute.

Views

Note
The options shown in the tab Options and the attributes Add tab/Columns will vary according
to the type of view selected.
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Important
Remember to combine the views with different types of graphs. This will give you multiple
possibilities for data analysis.

4.5.1. Tops
The Top view allows us to see what were the most prominent events as the time interval is selected.
What we envision in the graph is the sum of all these events displayed as a single event. If we lay the
mouse over each of these “peaks” or Tops, see the breakdown of the event by date, time and type of
dimension or attribute you are checking.

Views: Tops

4.5.2. Raw
This view provides raw data events, thus, we will see the total of events by segmented attributes by
time slots.
In the data table we will therefore collect all event data classified by columns. Data will be shown on
the screen, however, if you'd like to see more, simply scroll and wait for more data to load: Load more.
Raw view can provide graphics in periods of 3, 5, 15 or 30 minutes.
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Raw

Views: Raw

Note
As shown in the picture, the kind of graph ideal for the Raw view is data streams or Streams.
In the Raw view attributes are displayed in columns.

4.5.2.1. Managing Flow events in Raw view
The Raw view allows us to display all collected events by the raw Flow sensors, by attributes and
segmented by time slots. Combined with a Stream graph, also displays the data flow that is occurring
within the network.
Each column in the data table shows the values that correspond with the selected attributes. In this
table we can perform different actions:
• Time interval or Timestamp: can see the time interval that is referenced to show the number of
events that have occurred in that time.
• Check event information: click on the icon “Edit” for greater granularity.

Icon “Edit"
When you have reached the limit of granularity at which you can display events, this icon will
transform the information:
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Timestamp details: event information
Clicking on it we will access a screen that provides the complete information associated with each of
the events set forth in that time interval.

Event information
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Map
• Create object: some of the attributes shown in the event information allow the possibility of
converting into an Object. This means that these values can add a name and a description allowing
the localization of an item more quickly and easily.

Create object

Note
Remember that the maximum granularity available is 1m.

4.5.3. Map
This is one of the most visual options that we find in the view menu.

1

Option Map provides us a heat map that show the status of each Access Point (AP) of our network.

1

This option is only available in the Flow menu and has fewer options of filtering and data visualization than other views.
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Map
As shown in the picture, this view offers us through color coding, valuable information on the status
and use of the Access Point as well as a summary (right side) which includes the following data:
• Track client: click on the button to get specific information of an AP over a period of time. Enter the
MAC Access Point from which you want to track.
• Total active customers in front of partners
• Total of affiliates in front of detected clients
• Active APs in front of total APs
• Consumed bandwidth in our network

Color code: status of the Access Point
Zooming in on any zone of the heat map we can visualize the different AP our network
represented by a circle.
This circle includes figures indicating the number of users who are associated with the AP.
Furthermore, each circle will appear filled by different colors which indicate the status of each AP:
Green: Up is the AP, ie, in perfect operation.
Grey: AP status is unknown.
Red: the AP is Down, i.e. it presents malfunctions.
It also shows, through color-coding, traffic that is occurring in each Access Point. The gradation of
color indicates the varying traffic in the AP as a heat map: red, yellow, green and blue.
Additional information about Access Point
Click on Access Point and a box appears with the following information:
-Name
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Compare
-MAC Address
-Number of clients
-Date of last inspection

Important
It is possible to know the status of the Access Point from the option Sensors on the right side of
the menu bar, in the configuration area.
Select the menu you wish to consult. Click on the icon and select options View>Access
Points

4.5.4. Compare
This view gives us the evolution of the use of the network by comparing two time slots. This
comparison can be performed for hours or days at intervals of 5 minutes, ensuring a maximum degree
of detail. Thus, the user can quickly identify the peak of network usage.
In the data table which show those that correspond to the time interval selected.

Views: Compare

4.5.5. Unique
Through the viewUnique, the user can obtain information about the different elements that have
interacted, at least once with the network in a given time period. Laying the mouse on any point of the
graph, the user will get the total result of unique items for the selected time period.
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Group by (only available in the Unique view): allows us to group the data shown in the graph on
the basis of a given attribute. This option provides the filtering and sorting of items according to the
analysis criteria we need.

Views: Unique

4.6. Type of aggregation
The aggregation type allows the user to select the unit of measure in which you want the information
to be displayed.
These are the different metric units and you will find in this tab:
• bps
• bytes
• packets
• packets/s
• flows
• flows/s
• client
• quality
• wireless stations
• clients/station
• bps/client
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• flows/client
• fps/client
• bytes/station
• bps/station

Nota
Optimize your metric combining different types of aggregation granularity options (time periods)
which are available.

Selecting the type of aggregation

4.7. Granularity
We call granularity to the degree with which we can view events in redBorder. The options of
granularity vary by time range being displayed (1h., 2h., Last week, last month, etc.). With this view
the user can analyze network traffic in real time.
As shown in the image according to the selected time period, the user can know the traffic detail, for
example, sensor lapse of two minutes.
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Metric that has applied a granularity of 2 minutes

Note
The view Raw is the most indicated to apply granularity in order to observe the data in detail.
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Graph type
Combining raw view for a selected time period (granularity)

4.8. Graph type
As we will see in Chapter 5, Dashboards you can select the type of graph you want to display the
data provided in the different views. The options are very similar to those that are available in the
process of creating custom widgets.
The charts that are available at all times, will depend on the selected view. This option does not
appear, for example, by applying the Map view of the data, since the data is represented in this view,
on a map. These are the graphical possibilities of redBorder platform for views:
Stacked: comparatively show in the same graph the data for each of the selected attributes. (In the
image comparing traffic sensors).

Stacked graph for Tops view by sensor
Area: graph that provides an overlap of the data to a group of elements that belong to the selected
attribute, making the total traffic the sum of the traffic by attribute (in the image, by sensor).
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Area for graphical view of Tops by SRC Address: multiple elements
If they want to display on a single graphical element, just click on any point on the graph thus isolating
the selected item.

Area for graphical view of Tops by Sensor: single element
Line: graph that provides an overlap of the data to a group of elements that belong to the selected
attribute; in this case the area is not displayed but the graph is represented by line.
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Line graph to Tops by Sensor
Bars: provides an overlap of data to a group of elements that belong to the selected attribute, being
the total, the value sum of each of those elements. In this case, the data is represented through bars

Bar graphs for Tops view
SBars: or Stacked Bars, provides in the same graph the data obtained for each of the elements
included in the selected attribute, so you can view the results of independent IP, sensor, etc.,
represented in bars.
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SBar graphs for Tops view by SRC Address
Streams: graph only available by the Raw view. Shows traffic flow by sensor.

Stream graphs (only in Raw view)
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4.9. Options
Each view has a number of options that allow the user to, among other things, display the total traffic,
export the data to a CSV or take the machine to a state of the past in order to analyze and compare
current and past behavior.
Next all available options in this tab are listed. The user should be aware that these options vary
according to the previously selected view.
• Show Total: Selecting this option is shown in the graph the value of all the differentiated traffic
received or issued by each of the attributes that can be queried. When this option is active, the list of
options “Hide all” appears. Available in the Top and Unique view.
• Export to CSV: the user will download a file in CSV format that includes the data which
corresponds to the attribute selected, it may set a limit of rows to be included in the file. Available
only for Tops and Unique views.
• Time machine: returns the machine to a previous state. By selecting this option the user can view
the data as if he were seeing them in the last day and time you specified. Available for all views
except for Raw.
• Save tabs/columns as default: to apply this option, columns or tabs data have been
included for analysis are displayed by default in the new consultations performed. Available for Raw,
Unique and Tops views.
• Sort aggregations: through this option, the user can choose the order in which the columns or
tabs are displayed. Available for Raw view.
• Start reloading: activates the countdown to the data reload. At any time, the user can stop this
by selecting Stop reloading (Start option replaces reloading once this is enabled). At the left end of
the section bar appears a countdown indicating the time out to reload. Available for Raw view.

Options: Show total
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Options: Export to CSV

Options: Time machine
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Attributes: tabs and columns

Options: Sort Aggregations

4.10. Attributes: tabs and columns
The attributes help us carry out a comprehensive and personalized analysis for each of the elements
involved in the flow of network traffic of our organization. These are organized into tabs or columns
to the view that we are consulting. The options shown are common to all views except for the case of
Compare (offers only comparability for weeks or months) and Maps, in which case this section is not
shown.
We also stop at two useful options for locating IPs that generate more traffic: Scatter Plot and SRC/
DST MAP.
Next we list the attributes that the user has available and the different aspects that we can consult of
each one:
• Application
-Application
-HTTP Host
• -Darklist
-Darklist Category
• Datalink
-Client vendor
-SRC Vlan
-DST Vlan
-TOS
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-Wireless ID
-Client band
-Client ID
-Client Status
• Flow
-Biflow direction
-Direction
• Interface
-INPUT SNMP
-OUTPUT SNMP
-INPUT VRF
-OUTPUT VRF
-Wireless Starion
-Client RSSI
-Client RSSI Value
-Client SNR
-Client SNR Value
• Location
-SRC Country
-SRC AS
-SRC MAP
-DST Country
-DST AS
-DST MAP
-Coordinates
-Coordinates Map
-Service Provider
-Namespace
-Deployment
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Attributes: tabs and columns
-Organization
-Campus
-Building
-Floor
-Zone
• Network
-Conversation
-Protocol
-Protocol Version
-Sensor Type
-Scatterplot
-SRC NET Address
-DST NET Address
• Transport
-SRC Port
-DST Port
Scatter Plot
In the Network attribute menu we find Scatter Plot, an option that gives us an idea of the distribution
of network traffic. In a graph representing coordinate points through IPs that interact with the network
traffic in real time. In the horizontal axis the show the IP destination and the coordinates, of the IP
origen. The more traffic generated, the thicker the point.
Putting the mouse over each of the dots on the graph, we obtain the IP address associated with it.

Note
Remember that any time you can isolate one or more IPs by applying filters: enter IP source and
IP destination in the search box, or select one or more rows of the table.
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Distribution of network traffic: Network>Scatter Plot
SRC/DST MAP
In the Location attribute menu we find the options SRC MAP and DST MAP. In both cases we offer the
possibility to display the map which is the localization of the IP of origen (SRC MAP) and destination
(DST MAP) that generates the most traffic.

Distribution of network traffic: Location>SRC/DST MAP
When there is more than one IP connected in the same geographical point, these are clustered and
displayed as a point with the biggest size that includes a number. This number indicates the total
number of IPs connected at that location. For the detail of the IPs, simply apply to the map or zoom,
double click on the point you want to get more information.
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Location of network traffic: connection details

4.11. Reports
Reports module is closely relationated with events. It allows the user to get customizated reports
showing the information about his system.

Reports
To create a new report we will click on New Report button and will fill all the fields. Here we can select
parameters like schedule type, sharing users or sharing domains. Once the report is created it will be
shown in the report list seen before.
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Reports
Is also possible to import a report from a file using Import Report button.

Reports
In the report list we have the possibility to edit an existing report or also generate it in PDF or send it
by email, all this options are in the edit button in the right of the list.
The blocks of the report can be also modified choosing the block edit option in the report list, where
the user will be able to add, move and delete any kind of block for the report.
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Dashboard
5.1. Dashboard options
The first option we find in the menu bar in the analysis area is the Dashboard. This is the selected
option by default you will see as soon as you log in the redBorder Manager administrator:

General view of the dashboard
The dashboard section presents multiple options:
• List of dashboards available: the first part of the dashboard menu, the user will see the
dashboards that have been created and are available for their profile.
Next to each of the dashboards are two icons. The first, the wrench icon, allows us to see and edit
the general configuration of the panel. The Copy icon to the right will allow us to clone the selected
dashboard.

Editing and cloning dashboard icons
• Add dashboard/Import dashboard: these options allow you to add a new custom dashboard
and import those that are already created, in order to share them with other users or that are
available to other profiles. The dashboard creation and importation process will thoroughly see lines
further ahead.
• Add Widget: add that widgets that you want to fully customize your dashboards.
• Update time: the data in the dashboards are updated every 5 minutes (300 seconds). You will see
a countdown of the time remaining until the next update. You can reset the account by clicking on
the figure shown. At that time, the word “Stopped” will appear. Click again to start the countdown
from 300.
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• Unlocked: the user has the option to lock/unlock the dashboard that they are consulting so that no
other user with permissions can edit the dashboard.
• Time machine: allows the user to “travel back in time” and see the results of the metrics of a
particular day and time.

Dashboard section option details

5.1.1. Edit and clone available dashboards
Edit dashboard: General Settings
The user may at any time modify the information associated with each of the available dashboards by
selecting General Settings, by clicking on the tool icon.
Editable information in the general settings of the dashboard:
• Name
• Set this dashboard as default
• Layout
• Description
• Background color
• Dashboard users: add and delete
• Dashboard domains: add and delete
Furthermore, in the bottom of the screen the user will see a number of options available:
• Update Dashboard
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• Cancel
• Delete
• Convert to report
• Export dashboard: the system will create a compressed file for the download; this is a necessary
step if you want to import.

Edit dashboard
Clone dashboard: It is possible to clone (copy) dashboards in order to have them available for
different users, imports, etc. To do this, simply assign a name to the copied dashboard.
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Clone dashboard

5.1.2. Add dashboard
The dashboards allow you to have a visual summary that includes the main KPIs that are necessary to
analyze the network infrastructure. The user can combine a number of widgets that allow, in a single
glance, to obtain valuable information on trends, changes and exceptions associated to traffic that
1
occurs in or passing through their network.
To create a new dashboard you must select the option Add dashboard. Then enter a series of
general settings data and save the changes using the button Create dashboard.
The first step in creating a custom dashboard is creating a blank panel, which afterwards, the widgets
can be added that meet our viewing needs.
To create a new dashboard, we must indicate a number of preferences in the General Settings
interface, as described above for editing dashboards.

1

(In the Community version, there is a limit of one dashboard).
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Add dashboard

5.1.3. Import dashboard
The option Import dashboard it is very useful in the case you want to share dashboards with other
users, or incorporate redBorder information from other compatible applications.

Note
To import a dashboard, it is necessary that this, previously, has been exported as a compressed
file and is available among our files.
Select the file that you would like to import and then click on the option Import dashboard. Once
we have done this import, we will find this new dashboard in the list of available dashboards.
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Import dashboard

5.1.4. Add widget: Customize dashboards
The user can create and add widgets to their dashboards in order to fully customize the display of
data obtained by different Modules. It is possible to incorporate both preconfigured widgets, as well as
create 100% customized widgets.
The first step is to select the type of widget you want to add. There are two types of widgets,
depending on the type of information you want displayed:
• Modules: data display received by the different Modules.
-Traffic
-Intrusion
-Monitor
-Social
-Vault
-Mobility
• Status: display the configuration and status of the machines and network infrastructure.
-Infrastructure
• Format: it configures the content and format of widgets: text, images, URLs, etc.
-Shapes
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Select type of widget
Degree of customization of widgets:
• Preconfigured widgets: some of the widgets that the user can select by double clicking, contain
preconfigured information, which can be added to the dashboard you are working on.
• Semi-customized widgets: some widgets contain a number of data indicated by default, however,
the user will have to complete some general information details about the widget.
• Custom widgets: 100% customized. This means that the user will have to define all the information
contained in the widget.
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Traffic widgets

Customize your widget: Complete general settings details

5.1.4.1. Customize a product widget
Some of the widgets that the user finds available to add to the redBorder platform dashboard allow for
a complete customization.
First, let's see what customization options are included in this type of widget.
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The first step to customize a widget is to select the data display mode or cardinality, that is, how we
want to display the values or data in a particular column.

Note
Events received by the Manager consist of "column: value" pairs. The values given in
each column can be understood as the event's own data, which can actually provide us with
information.
Throughout this document there may be references to the concept of column as attribute.
The first step to customize a widget is to select the display mode of the data, and you can also
choose, views in which the cardinality is represented.

Widget customization options
Configuring widgets according to event views:
Raw: shows raw events (without aggregation).
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RAW view
Tops: add events based on a unit in order to show the most prominent, in a way that shows the total
sum of data from different events displayed as one.

Top Views
Compare: comparison over time (hours, days, weeks and months) of the most prominent.
A use example would be to compare different days in the evolution of traffic for a particular application.
Unlike Tops view, this only allows the graphic style "Serie".
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Compare View
Cardinality:
• Single Unique: with this option, occurrences or events of a column are isolated to a specific time.
• Grouped Unique: with this option, occurrences or events of a column are isolated to a specific time
grouped according to the determined criteria.

Single Unique View
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Grouped Unique View
Graph: The user can choose between different graphic styles available depending on the selected
display.

Serie Graph
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Stream

Pie
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Value

Horizontal bar
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Vertical bar

Table
Next step: Then enter the information requested on the form and press Create widget. At this
time the new widget is added to your dashboard.
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5.1.4.2. Customizing a status widget
The user can choose between two types of widgets applicable to the redBorder Manager
Configuration options:
Infrastructure: this option allows you to select the mode that will display information about the
configuration and the status of the network infrastructure.
1. Sensor: Map/Tree
2. Cluster: Diagram/Table
3. Alarm: insert configuration details in the form below.
4. Monitor: Serie/Value

Options of status widgets

5.1.4.3. Format widgets
Shapes: this option allows you to edit and insert auxiliary elements in your widgets such as text,
image, widget shape and embed a custom URL.
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Options of format widgets
To enter any of these elements to the widgets, simply complete the form that appears in each case
and apply the changes by option Create Widget.

Editing form of format widget
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5.1.5. Time machine
This option returns to the status of the machine during the day and time you have determined. The
user will see the data as if it were in real time.
This "travel back in time" offers us a maximum degree of accuracy in the analysis because it can
indicate the exact minute you'd like to consult.

Time machine

5.1.6. Clone, edit, reload and delete widgets from the dashboard
The user can directly access the widgets from the dashboard. In the top right hand corner a menu
appears which gives direct access to the following actions:
• Clone: allows duplicating the widget and incorporate it directly into the dashboard the user selects.
• Edit: gives access to the general settings of the widget to edit the fields that you want.
• Reload: Data updated.
• Delete
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Clone, edit, reload and delete widgets from the dashboard

Direct access to a widget from the dashboard

Warning
When you select the option Delete, the system will not display a confirmation prompt, so you
should be sure that you want to delete that widget. In case you accidentally delete a widget,
remember that you can always go to the "Add widget" to reinsert or duplicate any of similar
characteristics, and then edit it.
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Sensors
In Sensorsthe user can make queries, manage and make configurations of their network
infrastructure through the creation and edition of domains and sensors. There are many views that
offer the possibility to make different actions on their network elements.
Sensors is available in the top right margin of the header menu, next to Tools section and User's
Area. This menu area is named as Configuration zone, because unlike the options available in the
top left margin (Analysis), these allow the complete management and configuration of the Manager
and sensors: rules policies, alarms, cluster configuration or user's management, among other actions.

6.1. Sensors: menu and options
The organization of this sections is very similar (in terms of structure) to the other parts of the web. We
can find in this case:
• Section submenu: configuration and sensors'management options.
Expand all: It fully expands the sensor tree.
Collapse all: It fully collapse the sensor tree.
Options
+Add sensor
+Add Domain
View
• Main area: the information that is shown in this area depends on the selected View. There are four
available views in order to visualize our network infrastructure:
Tree: list with the different levels that compose the network infrastructure classified by dependency
and hierarchy. Alongside each element are two icons for editing and deleting actions. This is the
view that is displayed by default.
Map: locate the domains and sensors over a map.
Access Points: direct access to the visualization of the deployed Access Points.
Sensors: in the View the user can find a list of available sensors depending on the Apps
included in your license. Click on the sensor you want to check for view an alphabetic list of all the
sensors associated with this App.
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General view of Sensors section

Note
Each view has its own options menu and the different possibilities of creation and edition of the
sensors or domains.
Map view hasn't any available option.

6.2. Options
Here are the options available in the Sensors section. They can be selected from the Options and
from the options shown by clicking "Edit"both domain level and sensor level.
• Import Tree
This option allows to import your network infrastructure through the uploading of a file to redBorder
platform. This will be shown in tree view.

Import Tree
There are two ways to import tree:
1. Options->Import tree
2. Edit icon (domain level)
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View

Import/Export tree from Options menu
• Export Tree
This option allows to export a tree and is within easy reach for other applications. User will download
a zip file for storing then in their computer.
There are two ways to export a tree:
1. Options->Export tree
2. Edit icon (domain level)

Export Tree
• Wakeup Chef Cluster
• Cluster data
• Indexed data: Show indexed data statistics for the cluster
• Historicals: Show information about the historical data of the cluster
• Realtime: Shows information about Realtime process

6.3. View
When the user access to the Sensors section can find a list (Tree view) in which the domains and
sensors that are a part of their network infrastructure are shown. In this point we are going to review
each view and the actions available.
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View menu: options

6.3.1. Tree view
Tree view is shown by default in the Sensors section. It is a list with the different levels that compose
the network infrastructure classified by dependency and hierarchy.

Tree view
From this view, the user can add a new domain or sensor, delete the existing, access to other views,
import and export the tree as well as direct editing of all the domains and sensors that are a part of the
list.
Every element that is shown in the tree has two icons: Edit and Delete. (The same icons work in tree
and sensors view):

"Edit" and "Delete" icons

Note
The options in the Edit menu can change depending on if we are consulting the infrastructure at
domain or at sensor level.
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Tree view

Warning
Some sensors can't be deleted.
In these cases, the "Delete" icon will appear colored in grey. Before the domain or sensor will be
deleted, the system will show you a pop-up screen with a warning message.
All the users and descendants assigned to this domain or sensor will be disable and assigned to
the parents of this domain or root domain. The user with Administrator role should activate user's
permissions from Tools>Users section.

Confirm the deleting of the sensor
In case that IPS/IDS sensors have been registered an icon with the type of policy it has will be shown.
Click on this icon to access the interface for this policy and from which we can perform some different
actions.

Policy icon
Available actions in Tree view
• Add a new domain or sensor
• Delete a domain or sensor
• Access to other views
• Import and Export the tree
• Edit a domain or sensor

6.3.1.1. Infrastructure organization levels in redBorder
• Domain: containers which may include sensors, group of sensors, etc. Domain level shows us the
domain name and allows us to add a description. It is possible to classify them according to their
nature (organizational, spacial, etc.); each one will have an identifying icon:.
• Generic
• Service Provider
• Organization
• Market
• Deployment
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• Namespace
• Campus
• Building
• Floor
• Sensors: end nodes that correspond with physical elements placed on the network (switches,
routers, IPS, etc.).
The information in sensor level is: sensor name, IP, policy (IPS sensors), last check and version. It
is possible to add a description to the sensor.

Note
Note that to create IPS sensors you must do that through the registration of the sensors in the
Manager in the Manager Installation process. From this section you can edit and overwrite the
parameters that they have inherited from Tools->General Settings
The sensors of the rest of the Apps can be created from Sensors section.
Configuration inheritance
In Tools section we find General Settings option from which the user can define general parameters of
the Manager and Apps.
This is the maximum level of configuration (it acts as root domain) therefore, the properties defined
here will be inherited by domains and sensors that fall below this level.
When a domain or sensor is created or it is edited for the first time, we can observe that some
parameters have the tag "Inherited", it means that they have inherited the values from General
Settings. Overwrite this information in case that you want to change it.
The domains and sensors that fall below the level of the element overwritten, inherit again, the
properties applied to this element.

6.3.1.2. Monitors
Note
This option is only available in the Edit icon menu (sensor level).
Click on sensor's Edit icon and select Monitor option. Then, we can see a list with the monitoring
metrics using for monitor the sensor status at different levels. Technology column indicates the origin
from where the data is collected.
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Monitors edit icon
These are the available actions for controlling the satus of the sensor:
• Restore default: applies default metrics that are included in sensors creation.
• Add monitor: shows available metrics. (+Add Monitor)
• Delete monitor: delete the metric applied.

Monitors

Add Monitor: available metrics

6.4. Map view
In this view, the user can see where the domains and sensors are located. It is possible to add a new
location, both for a new domain/sensor and for an existing one.
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Map view
Add location
To add a sensor to Map view it’s necessary to add first a location in the domain or sensor editing
interface that has been selected.
For this, you can edit them when you add a new one (+Add Sensor/Domain) or by editing an
existing one using the Edit icon. In both cases you will find a paragraph called Location in which a
Map is shown; you can find the desired location or point by clicking on the map. Then select +Add
Location tab.

Create/Edit sensor: Location
If you have searched or selected a localization, the fields with the coordinates will be shown filled.
Otherwise, insert manually that values.
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View Access Points

Define coordinates to add a location for a sensor or domain

6.5. View Access Points
Access Points (AP) are access points of the network infrastructure which are associated with a
location. The Access Points depend on the Flow App and apply to both the domain level, as well as
the sensors.
This is another way to display your network infrastructure, through the distribution of the APs per
domain, and you can also view the status of each AP. You can access the display or create access
points in two different ways:
• View->Access Points
• Edit icon to sensor/domain level->Edit: View Access Points (located in the submenu upper right
side).

View Access Points

Note
To find out which level you are, you can check the shipping route in the upper left margin. You
can browse through the different screens by clicking on any of the items of the route.
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The submenu of this interface shows a series of buttons similar to those on the main screen Sensors.
The actions you can perform from this screen are as follows (these vary depending on whether it is
consulting a domain or sensor level):
• Show Map/ Show Floors: shows the geographical distribution of access points or its plant location
in the case we are consulting a domain Floor with more than a floor level.
• Edit (sensor name or domain): we return to the editing screen for the domain or sensor.
• Options->Export Access Points/ Delete All Access Points.: allows you to export all
Access Points to a .csv file or delete all the Access Points defined for that localization.
• +Add sensors: add sensors to the domain we are consulting.
• +Add Domain
• View: menu that allows us to navigate through the different existing views.
• +Add Access Points
• +Add Zones

Access Point summary
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View Access Points

Add a new Access Point zone

Access Points (Zone)

87

Chapter 6. Sensors

Add a new AP zone

6.6. Add a new domain
Select option +Add Domain which is located in the upper right submenu, choose the type of domain
you want to add, and then fill out the required fields (these vary depending on the type of domain to be
created).

Add a domain: domain selection
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Edit a domain

Add a domain: fill in the data to create
From this moment, the rest of the information associated with the domain will need to be modified by
clicking the edit button to the right of each domain in the tree view, or Access Points and selecting
the option Edit.

6.7. Edit a domain
From this interface you can modify the settings of an existing domain, and enter the information of a
newly created domain.
To access this screen the user must click the edit button to the right of the domain you want to edit
from the tree view or Access Points and select the optionEdit.

Example of editing a domain
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This is the general data that we can modify for the domains. However, depending on the type of
domain selected, one of these fields will appear:
• General: displays general information of the sensor. Name (not editable from the Web), type of
domain-select the domain type in the box) and description.
• Servers: In this section the user can define the configuration of the Proxy and Syslog servers. All
values shown are inherited by default. Overwrite if necessary.
• Location: Locate the sensor/domain on a world map. This location will be displayed in the view
Map.

6.8. Add a sensor
Among the submenu options, we find +Add Sensor. In the dropdown menu they show the different
sensors available to add to the network infrastructure.
Select the type of sensor in the drop-down menu, and then complete the information requested.

Warning
In this section you can only edit and configure IPS/IDS sensors.
IPS, IDS and Mail Gateway sensors are created during sensor registration proccess after
Manager installation and Network configuration.
From this section you can only create directlu Flow sensors.

Add Flow sensor

Important
In the moment in which a redBorder sensor is created, by default it's set as the root, above the
domain level.
The user can organize its sensor infrastructure in any moment, dragging and dropping the sensor
in the level they want to place it in.
The sensor automatically inherits the properties of the root domain (policies, operating
mode, Snort variables, etc.).

6.9. Sensor types and Monitor device configuration
In the sensor section of a redBorder manager, the user can find the different types of sensors, each
one performs a different function:
• Flow
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Monitor device
• MSE
• Meraki
• Aruba ALE
• Monitor device
• Twitter
• Vault

6.9.1. Monitor device
The monitor device sensor is one of the latest developments that comes with the 80-6 version of
redBorder. It can be used to monitor any device with an ip address that supports snmp, redfish or ipmi.
When creating or updating the monitor device sensor the credentials for the corresponding protocols
needs to be defined. In case no community string for snmp is defined, the default ‘public’ will be used.
Once the user are logged in into the manager dashboard, the sensor can be added using the menu
‘Sensors > Add sensor’ and then clicking on ‘Monitor device’.
It can be prompted for some required and optional parameters.
• A unique name
• The ip address of the machine the user want to monitor
• The protocol the user will use to monitor
• The credentials of the machine to access the selected protocol
• The community string in case the user will use snmp protocol

Press on the ‘Save’ button to apply the configuration
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Note
Different sensor configuration guides can be found on the reBorder support page:
https://support.redborder.com
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Tools and Administration
On the right side of the menu bar, next to the menu Sensors we find the “tools” section or Tools
where you can find the options for the configuration of the redBorder platform.

Tools: available options for configuring the redBorder platform
From this menu you can establish the conditions to be met so that the user is notified by an
alarm, track the activities of the users of the platform, to register new users or to manage cluster
configuration, sensors and servers, among other actions.
These are the options found in the tool menu:
• Alarms: establishing the conditions for activating a user notification.
• Audits: allows tracking of user activity using log.
• Cluster Settings: shows us the settings that have been established for the cluster in the
Manager installation process.
• General Settings: the user can establish the general parameter settings of the Manager, as well
as the Apps they have registered.
• Correlation Engine Rules: provides the list of the cep rules. Here we can also check the
existing rules and create new ones.
• Monitor Categories: shows the current categories being used from snmp and allows the
creation of new ones.
• Licenses: list of the licenses under those that operate the different modules of the redBorder
platform.
• Lookup Sources: list of URLs of web services of network data consultation.
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• Objects: network objects defined in the redBorder platform.
• Overlay Maps: images that can be superimposed on a map with the latitude and longitude
indicated.
• Platform Alerts: shows the current platform alert to every user.
• Rule Versions: list of the licenses under those that operate the different modules of the
redBorder platform.
• Support Center: direct access to support center. It is necessary to be registered in support page.
• Users: profile management and user permissions.
• Worker and Job Queue: show the current active and stored workers and jobs on Redborder
manager.

7.1. Alarms
An alarm is a notification that is triggered when one or more conditions are met by the user.
By accessing this option the list of alarms that have been registered are displayed.

List of active alarms

7.1.1. Create new alarm
By clicking on the button +New Alarm we access the form, in which the conditions will be established
that the alarm must meet to activate a notification, and the degree of severity defined for that alarm.
This form consists of three sections:
1. General settings
2. Notifications
3. Conditions
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Create new alarm

Create a new alarm
General settings
In this section, the user must complete the following data:
• Name: alarm name.
• Time window: time interval that must be overcome by excess or default values given in upper/
bottom limit so that the alarm is active.
• Notify every: set time sequence for notification.
• Upper/ Bottom limits: indicates the number of events (maximum/minimum) that must meet the
conditions of the alarm to activate the notification.
• Product type: select the type of App/item for which the alarm has defined.

1

-Traffic
-Intrussion
-Monitor
-Social
-Vault
• Severity: the user must define the severity level that's given to the alarm. Depending on the
conditions you have defined for the alarm will imply a very low risk, low, medium, high, very high or
critical. This gradation of severity is also indicated on a color scale.

1

The user will see in this field options that are included in their license.
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Notifications
In this section, the user will select the means by which the alarm is notified and will introduce the data
for the method chosen. Activate the check option you want for the notification:
• Notify to Syslog: check that to export the notifications to an external syslog server.
• Notify to email: check that to receive an email when a alarm is raised.

7.2. Audits
Option AuditsThis option shows a list of the recorded user activity in the redBorder platform,
chronologically ordered, by default.. However, the user can sort the table in an ascending or
descending way for each of the columns. You can use the search box located on the top to filter the
information you want to see. The columns displayed in this table are the following:
• User: user that did the action
• Resource: item that has been created, modified, or deleted.
• Action: action that has been carried out (creating, editing, deleting).
• Message: brief description of what has been audited.
• Timestamp: date and time of the activity record.

Audits: user activity record

7.3. Cluster Settings
Option Cluster Settings allows us to check the status and cluster settings, set the cluster creation
process during the Manager installation process.
You can modify these values by editing through the unlock button Unlock. The information can be
changed with the following parameters:
• Cluster Status
• Virtual IP Addresses
• Historical Nodes
• Historical Rules
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Cluster Settings: status and cluster settings

7.4. General settings
Option General Settings shows us an interface whose editing will be determined for both the
platform configuration, as well as the network infrastructure, as it was explained in the chapter about
sensors.

General Settings: general settings for redBorder Manager

Note
To view all sections, it's advised to enable the option Show advanced options located on the
top right of the screen in general settings.
In this screen you can edit the parameters of both the Manager and the Apps that have been
registered. Therefore, the sections displayed will depend on the Apps that are integrated into the
redBorder platform.
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General Settings: advanced options
To perform a basic configuration in Manager, the user can edit general parameters, characteristics of
the Apps, server configuration, network, routes and geolocation of the IPs.
General parameters
In this section the user can change the following elements:
• Company name: Name of the company using Redborder
• Company email: Company email. Will be used as the report sender and license management
• Web URL: Interface URL
• Autoreload dashboard time: Refresh period for the dashboards (seconds)
• Autoreload raw time: Refresh period for the interface (seconds)
• Rule Update Job Periodicity: Periodicity for updating the Rules
• Rule Update Job Time UTC time when the Rule Update Job will be executed
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General settings: editing general parameters

Important
All parameters defined in this interface are inherited by those elements that are found on lower
levels in a dependent state (domains, sensors). To modify this information, the user must write or
edit it, as described in the chapter about editing sensors and configuration Sensors.
IPS/IDS Settings
Here we can set in Redborder the IPS/IDS physical setup and configuration.
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General settings: IPS/IDS Settings
HTTP SSL Certificates
Allows to set a SSL certificate for secure communications.

General settings: IPS/IDS Settings
Servers
Configuration of servers Syslog, MTA, NTP and enable proxy settings.
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Note
An example of how to configure servers is in Chapter 11, “Editing sensor and/or domain."

General settings: server configuration
Default Rules
Configuration of Default Rules for loading or dropping data.
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General settings: Default Rules
Monitoring and Logs
This section helps you to momitorize redBorder infrastructure. In the field Syslog Servers you have
to indicate in which remote server, logs are going to be sent.
You must select which protocol and which Syslog mode you want to use for the sendings.

Note
TCP protocol is recommended in order to guarantee a safe sending. Choose this option
whenever possible.
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General Settings: Monitoring and logs
The section New Relic allows you to report to New Relic cloud. In this case, the user have to indicate
the number of their New Relic License and if they have a Cluster group, write its name.
The activation of Enable Plugins check is optional because this is a payment service. Activate
Enable APM in case of web monitoring.
Amazon CloudWatch
If user wants to send their logs to this Amazon Service, required fields must be filled.
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General Settings: Amazon CloudWatch
Google Maps API
Is possible to link Redborder with Google Maps API to get better location information.

General Settings: Google Maps API
Backup segments (Remote S3)
104

General settings
It enables a backup of user's data in a remote server or database. For this, it is necessary to indicate
Hostname, Bucket, and Access and Secret key.

General Settings: Backup segments (Remote S3)
White network
In this section the networks are indicated whose traffic will pass without package inspection, because
the networks are considered “reliable.”
Add a new network: click the button +Add and indicate the network IP.
Delete a network from the list: through the icon “Delete".
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General settings: Add a new White Network
Black Networks
List of networks whose traffic should be blocked because of the bad reputation.
Add a new network: just click on the button +Add and indicate the network IP.
Delete a network from the list: through the icon “Delete".

General settings: Add a new Black Network
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General settings
Network Routes
In this section the user will define the network routes for Manager.
Add a new network: click on the button +Add and indicate the network IP route.
Delete a network from the list: through the icon “Delete”.

General settings: list of Network Routes
Fixed Hosts
In this section the user will define the network routes for Manager.
Add a new network: click on the button +Add and indicate the network IP route.
Delete a network from the list: through the icon “Delete”.
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General settings: list of Network Routes
Geo IP
To enable Geo Protection function it is necessary to have an updated geolocalization database in
order to avoid errors in IPs geolocalization. redBorder has been configured to support only Maxmind
database format.
These are the types of databases that are admitted for IPv4 and IPv6 versions (binary format of old
GeoIp):
• Country: it determines the country of an Internet visitor based on their IP Address.
• City: it indicates the country, subdivisions, city, postcode, latitude and longitude associated with IPv4
and IPv6 worldwide addresses.
• ASN: GeoIP2 database of anonymous IP contains data about IP addresses of the networks that
have been used in a various ways by anonymous.
Download all the files from Maxmind website and unzip them. It is only possible to upload files
with .dat format as we can see in the image below. For this, click on +Select File
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General settings: GeoIP Protection

7.5. Correlation Engine Rules
Here the use can see all the rules for the correlation engine. It is possible to edit the existing rules and
also create new ones.

Correlator Engine Rules
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7.6. Monitor Categories
Here we can add a new category to monitorize the hardware. The categories use technologies such
as SNMP, Redfish or IPMI to provide information about the system and its functioning.

Monitor Categories
To add a new monitor category we must use the top right button. Then we will fill the fields selecting
the correct technology allowing Redborder to receive the data.

Infrastructure Monitor
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SNMP Operation

7.6.1. SNMP Operation
To explain the feature snmp operation we will use an example, monitor memory usage. When we
create a new monitor category using the New Monitor Category button from the Monitor Categories
page, we will see the following popup.

Initial creation of a monitor category
This is the formula to calculate the memory usage of a device:

The result is a combination of different snmp values. Now, if we want to create a monitor as the one
in this example, we must choose SNMP Operation in the technology dropdown. Now our form will
change to the following:

Create monitor with SNMP Operation
Under the OID field, now there is a button called Add new variable, which adds another field so we can
enter more snmp OIDs. Also, at the bottom, there is an OIDs Operation field, in which we will introduce
the operation we want to do with the OIDs previously entered.
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Example monitor
For every OID the output is going to be stored on a varaible which we will later used in the OIDs
operation.
Once at this point, we just have to create the monitor by pressing the create button.
To add the new monitor to a sensor device we will create a new sensor in Sensor tab, selecting
Monitor Device.

7.7. Licenses
Through this option the user can check which nodes have their liceses expired. In the same, it is
possible to upload a new license or request for a new one.
On the top edge of the screen there are indicated the number of available licenses, the Apps that can
be used under these licenses and the number of expired nodes. There is a list of expired nodes which
need to renew their licenses at the center of screen. There is also a list of the available actions.
To upload a file with a new redBorder license, click on Select file. To request a new license click
on Request a license.
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Licenses: queries and updating of expired licenses

7.8. Lookup Sources
List of the web services URLs which perform the network data queries. From this screen it is possible
to add more web services, as well as edit the existing ones.
Delete a service: click on "Delete" button.
Edit an existing service: click on "Edit" button:

Lookup Sources: queries web services
Add new web service: click on the button +Add Lookup Source.
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Add a new Lookup Source

7.9. Objets
The option Objects allows the direct creation and edition of Objects. The user can navigate through
different tabs that corresponding to the types of objects that can be created. If you want to locate the
objects in a more efficiently way you can use the browser.
Three kind of objects can be created:
• Net
• MAC
• VLAN

Objects: list of objects
Create a new object: click on New (Net, MAC, VLAN) Object
Edit an existing object: click on "Edit" button.
Delete an object: click on the "Delete" icon.

Objects: create a new net object
In all cases when you are creating or editing an object, the system asks you for a name, a value for it
and description.
In the top right margin an options submenu is shown. It allows user to import or export the data
concerning these objects in .csv format.
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Note
It is possible to create an object directly from the attributes that are shown in the tables, as in
Flow App as IPS. For this, click the inverted narrow that appears when we pass the mouse over
an attribute like IP, MAC or VLAN.

7.10. Overlay Maps
This option allows to overlay an image over a Google map in order to get more customization.
Edit Map: click on the "Edit" button positioned next to the existing maps list.
Add new map: click on +New Overlay Map.
In both cases, it will be indicated the name of the map, latitude and longitud in where the image should
be located.
Por último, subir la imagen desde su equipo en formato .jpg o .png.

Overlay Map: overlay images over a world map

7.11. Platform Alerts
Here the user can see the alerts from the platform. All the alerts are shown to every user.
There are three levels for the alerts: info, warning and danger. Each level has its own colour so the
alerts can be differenced.
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Platform Alerts
Is possible to create alerts for the platform using the New Alert button. Is necessary to select the alert
level, and the message of the alert.

Platform Alerts: New Alert
If the alert message is clicked by the user, it won't be shown again until the user logs in again.
Is possible to remove the alert by clicking on the cross in the message. After that the alert message
won't be shown anymore.

7.12. Rule Versions
The user can manage the sources for the rules of the platform. It is possible to add or upload new
sources and also enable the chosen ones. The rules are used for Snort probe, which is used by traffic
module.

Rule Versions
It is possible to upload rules for a particular IPS using the option Upload Source, where the user can
select the file to upload.
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Support Center
It is also possible to add sources for downloading new rules from the internet that are updated
periodically. If it is necessary the user can use the Force Rule Update to be sure that all the rules are
updated.

7.13. Support Center
The user can use the Support Center in order to solve any question or problem regarding the platform.
It is necessary to be registered in the Support Center.

Support Center

7.14. Users
The activation or modification of users' data, services management or the creation of new registers is
possible from the Users settings interface.
To search a specific user, introduce their data in the browser. You can also navigate through the
alphabetic list that is located on top of users list.
The only user that has permissions to do that is Superadministrator. The rest of the users can only
visualize the sections of the platform (reading mode) but not modify its content (except in the case of
its own user profile).

Users: management users'permissions interface
In the body of the screen we find a list that contains the active users in redBorder platform, email
address, Top Domain (maximun level that the user has access), number of times that they have
signed in, IP and hour from which they made their last access.
Clicking on the "Edit" button the user can modify the following information and visualize a summary of
their state and activity within the platform:
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Users: user's profile edition

Important
Every time that any data in a user's profile is modified, the current password should be introduced
to confirm the changes.
Active a new user: to create a new user click on +New User. Complete the information required in
the user's profile. Active Administrator check to obtain full permissions.
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Worker and job queue

Users: New user

7.15. Worker and job queue
In this option the user can check the status of work (Worker) and services (Job) that are running in
the background. You can also check which of these tasks have been completed.

Note
We call Worker programs that are steadily running in the background.
A Job is a program that runs periodically or only once, but it does not stay running in the
background, but runs and closes.

119

Chapter 7. Tools and Administration

¡Worker and Job Queue: status list of worker and job queue
Stored Jobs shows the list of finished services. You can know the status of each one through the
“Information” icon, or delete from the list using the “Delete” icon.
This screen automatically reloads every 5 seconds.

Worker and Job Queue: information of the state of a work
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7.16. User area
At the top right of the menu bar you find the user area, from which you can view notifications, check
the profile, access context-sensitive help and exit the system.

User area
Notifications
To view a summary list of notifications simply click on User's area. To access a complete list of
them, select the option View All or click on any of the notifications that appear in the summary;
in this way you can access a new screen from which you can view the details of notifications, and
remove all of them through the option Delete All.

User area: Notifications
My profile
This option allows direct access to the user profile and perform the same actions with the option
Tools>Users.

121

Chapter 7. Tools and Administration

Users: editing user profile
Show help
This option enables a context-sensitive help that facilitates navigation and usability of the platform.

User area: Help
Logout
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User area
For safe disconnection of the platform, select the option Logout. The system will return to the login
screen.

User area: login screen after Logout
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Advanced
In this chapter we will show some advanced settings and tools for Redborder configuration and
administration.

8.1. Architecture
Redborder has an open source based architecture, using technologies like Snort, Kafka or Logstash.
All these technologies are orquested by Zookeeper and Chef, so it is important to have those services
running for the good functioning of Redborder.

Architecture of Redborder

8.2. Operations
There are some important operations that must be executed in order to do advanced settings in
Redborder.
• motd: Motd shows general info about node and cluster

125

Chapter 8. Advanced

Motd: output
• rb_get_managers.rb: Shows information about nodes on the cluster

rb_get_managers.rb: output
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• rb_get_services.sh: Get all the services status on the node. Used with option all shows information
for all nodes. If optional the service is added too, only the status of this service is shown

rb_get_services.sh: output
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• rb_set_service.rb: Allows to enable or disable a service.

rb_set_service.rb: usage
• rb_service: Allows to work with a service. It can start, stop and restart services. Can be used with
services such as postgresql, riak, hadoop, zookeeper, druid, kafka, chef and more.
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rb_service: usage
• rb_set_topics.rb: Assign the destination of the topic. which can be samza of realtime.
Corresponding services need to be started to keep the correct working of the redborder platform.

rb_set_topics.rb: usage
• rb_cluster_configure.rb: Get all services status for all nodes. Allows to change the configuration
for the whole cluster.
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rb_cluster_configure.rb: usage
• rb_manager_ssh.sh: This command is used to move or execute another command on other node.

rb_manager_ssh.sh: usage
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• rb_manager_scp.sh: This script is used to copy a file from the manager where is being launched to
all other nodes or a list of nodes.

rb_manager_scp.sh: usage
• rb_cluster_reboot.sh: Order the reboot for all cluster nodes.
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rb_cluster_reboot.sh: usage
• rb_cluster_update.sh: It is used to upgrade the manager to a new released version.

rb_cluster_update: usage
• rb_get_tasks.rb: Gets information about indexing service.
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rb_get_tasks.rb: usage
• rb_wakeup_chef: Starts the chef-client in all the nodes.

rb_wakeup_chef: usage
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8.3. Redborder technologies
In this section we will explain the main technologies Redborder uses to manage and use all data it is
provided.
All main technologies used in Redborder are open source, which allows period updates and more
quality.

8.3.1. Siddhi
Siddhi is an open source Complex Event Processor that Redborder uses in vault module to apply rules
to incoming events. It allows us to create rules that can alert us from any kind of behaviour reflected in
the events.
Siddhi is used in Redborder to make it able to raise alarm when a determinate situation is present in
the network.
Siddhi uses an SQL sentence structure, so it is possible to edit all rules included in Redborder by
default.
It is necessary to have certain level of knowledge about Siddhi to create useful rules.
It is necessary to activate the correlation engine. This will use more machine resources, so it is
necessary to be sure that the system has enought RAM memory.

8.3.2. Snort
Snort is an open source network intrusion prevention system that process and analyzes real time
traffic.
Redborder uses Snort in intrussion module to
Snort system is based in rules, which are partially provided by the community.
It is possible to update the rules manually, so it ensures that, with the lastest set of Snort rules, the
traffic is being analyzed and monitorized.

8.3.3. Hadoop
Hadoop is an open source distributed processing framework that manages data processing and
storage for big data applications running in clustered systems.
Hadoop is used by Redborder to provide real time traffic analysis of Big Data.
Hadoop is not enabled by default in a Redborder manager, because of its requirements of resources.
It is very important to have strong resources to run Redborder using Hadoop, at least 64Gb.
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Uses Cases
In this chapter we will show some uses cases of Redborder. Some of them:

9.1. Use Case: Tracking an IP with Redborder
We can use Redborder to track a suspicious IP. Its possible to learn about its behaviour using Traffic
module
First of all we must know the ip we want to track. Once we have the IP we will go to Traffic module

Tracking an IP: Traffic module
Once in Traffic module we can use the Advanced Search from Filter button to see only the traffic
generated by that ip

Tracking an IP: Advanced Search in Traffic module
Here we can set the suspicious ip to filter all the traffic. We will use LAN IP metric for that purpose.

Tracking an IP: Filtering IP
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When we apply the filter we will see only the traffic for that ip.

Tracking an IP: Traffic filtered
Is possible to add new metrics to see the behaviour of the ip and what is doing in our network.

Tracking an IP: Adding new metrics
Now we can see what ports are being used by this IP.
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Tracking an IP: Ports being used by suspicious IP
With this use case we can see how Redborder is able to filter the traffic for one or more IP so the user
can detect bad behaviours for particular ip's, being able to track ip's with only a few clicks.

9.2. Use Case: Brute force authentication attack alert
We can use Redborder to alert of possible brute force attacks thanks to the use of its correlation
engine and the rules that are established.
First, we must go to the Correlation Engine Rules section located in the Tools part.

CEP rules
Then we will activate the rule we want to use. In this case: SSH Brute Force Authentication. Finally,
we must apply the changes.

CEP rules
This rule is capable of generating an alert when 200 unsuccessful log-in attempts occur in a 20 minute
time window on a Linux machine via SSH protocol. For this, it is necessary to have the corresponding
vault sensor created previously by referring to the IP of the machine which we want to protect.
Once this is done, in case of receiving a brute force attack, we could visualize the corresponding alert
by accessing the Vault module. To be able to view it easily, we can add a sensor tab and filter by CEP.
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Vault module: Brute force attack alert.
We can also display the alert message if we switch to the message tab.

Vault module: Brute force attack alert message.

Note
To expand the use cases, we can access the following link where the advanced use cases are
located:
https://support.redborder.com/hc/en-us/sections/360000254677-eXperience

9.3. Use Case: Reviewing remote information from
Untangle
Redborder has the capability to collect information from other manufacturers and use it to monitorize
remote systems.
In this use case we will show how is possible to review a remote system status which is being
monitorized by Untangle.
First of all we will access to Vault module.
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Vault module: General view
We will select Class metric from Untangle and will filter one of them

Vault module: Untangle Class metric
Once we have filtered the Class, we will see the Hostname metric which are using the filtered class.
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Vault module: Hostname view
We want to know which protocol is being used by the hostname and the class filtered.

Vault module: Filter view
Using the filter tool we can see that the protocol used by that particular hostname and that particular
class is UDP.

Vault module: Protocolname view

9.4. Use Case: Detecting an Eternalblue attack with
Redborder
In this case we will see how Redborder can use Snort rules to detect an Eternalblue attack.
All starts with a malicious pishing email which contains a dropper that installs a ransomware.
The ramsonware will try to use a known exploit to take control of all possible machines
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Eternalblue attack: Scenary
Redborder can use Snort rules to detect the SMBv1 protocol echo response used by the ransomware,
so we can use intrusion module to see the signatures to identify the attack.

Eternalblue attack: Intrusion
Here we can see the current signatures collected by Redborder.
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Eternalblue attack: Filtering signature
Once we have filtered the Eternalblue signature we can show SRC Address metric to track IPs
involved in the attack.

Eternalblue attack: Selecting SRC Address metric
Now we have the IPs of the machines involved so it is possible to take actions to solve the security
hole.
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Eternalblue attack: IPs involved in the attack

Note
It is important to have an updated version of Snort rules to detect weird behaviour and traffic with
Redborder

9.5. Use Case: Ssh brute-force attacks
In this case we want to protect and monitorize a critical ssh server, so we will use siddhi rules to track
any kind of brute-force attack.
Once we have the ssh server configured and we have already create a sensor for it in Redborder, we
need to enable the Correlation Engine.
To enable the Correlation Engine we have to introduce the following commands in the manager
terminal.
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Ssh brute-force attack: Enabling Correlation Engine
After that we will have to wait a few minutes to be ensured that cep is running. We can use
rb_get_services.sh script to ensure that.

Ssh brute-force attack: Correlation Engine enabled
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After that now we can go to Correlation Engine Rules from Tools menu.
We will use Ssh brute-force siddhi rule.

Ssh brute-force attack: Ssh rules
We can see the rule clicking in the edit button on the right.
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Ssh brute-force attack: Editing ssh rule
We are going to change the maximum number of attempts to 3
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Ssh brute-force attack: Edifint ssh rule
After that we must check the enable box of the rule and apply all the changes.

Ssh brute-force attack: Applying changes
In vault module we will see CEP sensor.
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Ssh brute-force attack: CEP sensor
We can filter by CEP sensor to see the messages.

Ssh brute-force attack: CEP sensor filtered
In message tab we can see the messages from the cep sensor, which shows is alerting that a bruteforce attack is being done.
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Ssh brute-force attack: CEP messages

Note
The correlation engine has a big potential due to siddhi rules. The default rules included in the
manager can be edited to adapt it to your purposes or create new ones.
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